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- Tabellen met AutoCAD 2008 - 
 
Indien men in AutoCAD een “tabel-achtige” oplijsting wenst te maken van een aantal 
tekstobjecten, zou men het MTEXT commando kunnen gebruiken om stukjes tekst uit te 
richten met tabstops. Vervolgens zou men er een kadertje omheen trekken met het 
RECTANGLE commando of zo, en nog wat lijntjes ertussen om de “tabel” eventueel nog 
wat op te delen. 

AutoCAD heeft sinds de 2004 release een functie gekregen om “tabellen” te plaatsen.  
Ze zijn simpel om te maken, bevatten heel wat functionaliteit, en zijn makkelijk te 
onderhouden. 
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1. TABELSTIJLEN 
De tabellen van 

AutoCAD 
baseren zich op 

een stijl, die – net 
zoals bij bematingen of 
tekst – het uitzicht 
ervan bepalen. Maar 
om een tabelstijl te 
definieren, moet men 
eerst de tekststijl in 
orde brengen, dit om 
de velden van de tabel 
te kunnen invullen. 
Deze tekststijl is ook 
meestal diegene die 
men gebruikt om te 
bematen. 
 

BONUS TIP: In deze tutorial baseren wij ons op een eigen tekststijl die de 
naam “Inventor Wizard” heeft gekregen. Het is verstandiger om stijlen te 
benoemen naar bijvoorbeeld uw bedrijf of organisatie, en niet verder te gaan 
met de fabrieksgeïnstalleerde “Standard” stijlen. Dit om enerzijds uw eigen 

CAD-standaard te identificeren, maar ook om makkelijke dataoverdracht tussen 
tekeningen mogelijk te maken. Wanneer bijvoorbeeld elke gebruiker / bedrijf de 
“standard” stijlnaam gebruikt (vermoedelijk met telkens eigen instellingen), dan 
kunnen externe objecten bij het invoegen (vb blocken) visueel afwijken van het 
originele document. De ingebrachte tekstobjecten zullen bij een reeds aanwezige stijl 
de bestaande overnemen (en dus niet zijn eigen). Het ingebrachte tekstobject kan dus 
op een totaal ander lettertpye weergegeven worden dan in het origineel. Twee 
gelijknamige stijlen met afwijkende beschrijvingen kunnen niet in 1 tekening worden 
ingevoegd, de stijl van de tekening zal dan worden gebruikt. 
 

Het dialoogvenster voor tabelstijlen kan 
men ophalen met behulp uit de “styles” 
toolbar, door te klikken op het “Table 
Style Manager” icoon, of vanuit het 
pulldownmenu Format → Table Style…, 
maar ook door op de commandoregel de 
opdracht “tablestyle” in te geven. 
Indien het AutoCAD Dashbord nog 
steeds aan je tekenscherm hangt, dan 
kan men van hieruit ook het 
dialoogvenster voor tabelstijlen starten. 
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Onderstaand dialoogvenster zal verschijnen, waarmee men tabelstijlen kan aanmaken 
en wijzigen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Om een nieuwe tabelstijl te maken, moet men zich steeds baseren op een bestaande 
stijl. De tabelstijl “Standard” is voorhanden in elke tekening en is niet te verwijderen of 
te purgen om zodoende minstens één basis te hebben voor een nieuwe tabelstijl. 

 

 
 

Vul een nieuwe naam voor de tabelstijl in, en bepaal op welke stijl men zich wenst te 
baseren om de nieuwe stijl te bepalen. Klik op “Continue”. 
 
 
 
 
 
 
 
 

Aktieve tabelstijl Uitzicht van de aktieve tabelstijl 

Lijst van 
beschikbare 
tabelstijlen 

Geselecteerde 
tabelstijl 
aktiveren 
 
Nieuwe 
tabelstijl 
maken 
 
Geselecteerde 
tabelstijl 
wijzigen 
 
Geselecteerde 
tabelstijl 
verwijderen 
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Door een nieuwe tabelstijl [New…] in te geven, alsook door een bestaande te wijzigen 
[Modify…] – bekomt men onderstaand dialoogvenster. 
 

 
 
Nieuw met AutoCAD 2008,  is dat men een nieuwe stijl kan maken op basis van het 
uitzicht van een bestaande tabel (=select table to start from). Met de fabrieksinstelling 
maakt men een onderscheid in 3 soorten celtypes: datacellen, kopcellen en titelcellen. 
Deze celtypes uiten zich weerom als een celstijl die in de tabelstijl opgenomen zijn. 
Maar men kan nog eigen celstijlen aan het lijstje toevoegen, zoals bijvoorbeeld een 
eindresultaat cel met grotere en vette tekens en een dikke celomkadering. 
Met een geselecteerde celstijl kan men doorheen de tabbladen “General – Text- 
Borders”  de eigenschappen ervan bepalen. De previews zal onmiddelijk weergeven 
welke invloeden de ingestelde eigenschappen hebben. 
 
 

BONUS TIP: Een “Fill color” zou men op RGB 255,255,255 (=wit) kunnen 
plaatsen zodoende dat eventueel achterliggende tekeningobjecten niet 
doorheen de tabel schijnen.  Iets wat men voorheen men het WIPEOUT – 
commando zou hebben opgelost. 
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2. PLAATSEN VAN EEN TABEL 
Het plaatsen van een tabel is een tekencommando en is daarom terug te vinden 
op de toolbar “Draw” of de pulldown menu “Draw” → “Table…”. 

Ook vanop de commandoregel kan met de ingave ”Table” de functie worden gestart, 
en alsof men nog geen keuzes genoeg moet maken in het leven: de tabelfunctie kan 
men ook nog starten vanuit het AutoCAD Dashbord. 
 
Vervolgens zal het “Insert Table” dialoogvenster uw aandacht trekken.  Linksboven dit 
venster is de aktieve tabelstijl zichtbaar, die men voorheen (bij de tabelstijl) al “current” 
had geplaatst. Maar indien nodig kan men ook hier een andere tabelstijl kiezen, er 
wijzigingen aanbrengen of een nieuwe maken. De opzichtelijke preview toont de 
tabeluitzicht met haar gerelateerde tabelstijl.  
Over de “Insert Options” met “data link” (zie hoofdstuk 5.1) en “data extraction” (zie 
hoofdstuk 0)  komen we later nog even terug. 
 

 
 
De rechter helft van dit dialoogvenster – bevat instellingen voor het plaatsen van de 
tabel. Met de optie “Specify insertion point” stelt men de omvang van de tabel in - door 
de kolombreedte, rijhoogte en het aantal kolommen en rijen in te vullen. Vervolgens 
wordt de tabel met een invoegpunt op de tekening geplaatst.  
 
Met de optie “Specify Window” zal de positie en omvang van de tabel op basis van 
een venster bepaald worden. De tabelindeling is vastgelegd door de instellingen van 
het dialoogvenster. Zo kan men bijv de “Column width” op 50 plaatsen, en de breedte 
van het ingavevenster zal bepalen hoeveel kolommen men kan verkrijgen. 
Na het plaatsen van de tabel – zal de titelcel voor invullen geaktiveerd worden. 
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3. OMGAAN MET AUTOCAD TABELLEN 
Eénmaal een tabel is ingevoegd in de tekening, – is 
het uiteraard mogelijk de tabel verder naar eigen 
wens aan te passen.  
De celomvang kan men beïndvloeden door op een 
cel of tabel te klikken, waarop grippunten zichtbaar 
worden. Door deze te verplaatsen, wijzigt men de 
afmetingen van de rij of kolom waar het grippunt 
betrekking tot heeft. De “trekkies” of driehoekige 
grippijlen rekken de ganse tabel in hoogte of breedte. 
En een heel mooi extraatje van AutoCAD 2008 is de 
“Table breaking”. Het onderste licht blauwe 
driehoekje - in het midden van de tabel - kan men naar boven trekken om een te lang 
geworden tabel op te delen in twee (of meedere) stukken. De twee delen tabel blijven 
wel één geheel, maar worden netjes naast elkaar uitgelijnd. 
Klikt men vervolgens RMK voor het snelmenu, dan vallen de functies “Size Columns 
Equally” en “Size Rows Equally” op. Met een druk op de ESC toets geraakt men dan 
weer van die grippunten vanaf. 
 

 
 
Klikt men in de cel, dan zal deze oplichten met een 
dikke omkadering met grippunten, en is bedoeld om 
op celniveau verschillende manipulaties te 
ondernemen. Om meerdere cellen op deze manier te 
selecteren kan men een window gebruiken of de shift 
toest indrukken en meerdere cellen selecteren. 
De lange “Table” toolbar bevindt zich even boven de 
aktieve tabel, en bevat functies voor het samenvoegen (= Merge Cells) van 
verschillende cellen, alsook de celuitlijning, omkadering, het blokeren (=locken) van 
de celinhoud en/ of formatering, maar ook voor het toevoegen en verwijderen van 
rijen en kolommen. Via de RMK snelmenu zijn deze functies eveneens te 
benaderen. 
 
Van een cel is ook de data 
formatering in te stellen, t’is te 
zeggen – het type van de celinhoud 
en de eigenschappen daarvan. 
Heeft men een reeks cellen die 
enkel cijfergegevens bevatten, dan 
kan men de celformatering op een 
decimaal cijfer plaatsen, de 
weergave en de aantal cijfers na de 
komma bijvoorbeeld instellen. 
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Om één cel beter te 
laten uitkomen tov de 
andere - om bijv. een 
resultaat weer te geven 
- kan de omkadering 
worden aangepast. Klik 
op de betreffende cel, 
en selecteer terug 
vanuit de RMK menu 
“Borders”. 
 
 
 
 

 
 
 
 
 
 

 
Wat niet ontbreekt is ook een MATCH CELL functie. De kaderinstellingen 
van Cell Borders, maar ook Cell Alignment kunnen zo snel en eenvoudig 
overgezet worden naar andere cellen. 
 
 

 
 

 
BONUS TIP: indien men vaker dezelfde eigenschappen van een cel 
herhaaldelijk wijzigd, is het zinniger om een apparte celstijl te voorzien die men 
kan opslaan in de tabelstijl. Deze celstijl is makkelijk toe te kennen via de 
functie in de snelmenu of vanuit de “table” toolbar. 
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4. INVULLEN VAN EEN TABEL 
De cellen invullen in een AutoCAD tabel is even makkelijk dan in Excel. Gewoon 
op een cel klikken en inhoud intypen. Misschien verkiezen sommigen om op de 

cel te dubbelklikken of de cel aan te klikken + RMK “Edit Cell Text”.  
 

 
 
De teksteditor – met ondersteuning van de “Text Formatting” toolbar is sterk 
vergelijkbaar met die van MTEXT. Typ vervolgens in de cel, en plaats de inhoud die 
men wenst in te voegen. 
Om tijdens deze tekstmodus - door de cellen te navigeren – kan men bijvoorbeeld de 
ENTER toetst gebruiken om 1 cel te zakken. Met de toestencombinatie SHIFT + 
ENTER navigeert men 1 cel hoger. De TAB toetsen surfen horizontaal doorheen de 
cellen - de TAB toets schuift de aktieve cel op naar rechts, en SHIFT+TAB toets naar 
links. Ook de pijltjestoetsen zijn te gebruiken om doorheen de cellen te wandelen. 
Klik buiten de tabel, of klik OK van de “Text Formating” toolbar om de ingave van tekst 
te onderbreken. 
 
Normaal gezien, moet men de tekstweergave – zoals lettertype, teksthoogte, kleur - 
niet meer  wijzigen – omdat de tekststijl gebonden is aan de tabelstijl. Maar indien 
men het uitzicht van de tekststijl toch wenst te overbestemmen, gebruik dan de 
mogelijkheden van de “Text Formatting” toolbar. 
 
 

BONUS TIP: indien men vaker dezelfde teksteigenschappen van een cel 
herhaaldelijk wijzigd, is het zinniger om een apparte celstijl te maken die men 
kan opslaan in de tabelstijl. Deze celstijl is makkelijk toe te kennen via de 
functie in de snelmenu of vanuit de “Table” toolbar. 
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4.1. FORMULES 
De cellen van een tabel mogen  ook formules 
bevatten die berekeningen kunnen uitvoeren op 
de waarden van andere cellen. Met een 
geselecteerde cel, kan men een formule 
opbouwen met de RMK snelmenu Insert → 
Formula, of via de “Table” toolbar door op het  
“get Fx” icoontje te klikken. Maar men kan ook 
de cel aktiveren, en de formule manueel invullen 
door middel van de tekst editor. 
 
Net zoals bij Excel, baseren de 
formules zich op de indikator van 
rijen en kolommen. Bijvoorbeeld: 
de linkerboven cell van een tabel 
heeft de indikator A1, 
samengevoegde cellen 
gebruiken de indikator van wat 
de linker bovencel zou zijn. Een cellenbereik wordt bepaald door de eerste en de 
laatste cel, met het colon symbool ertussen. Het bereik A5:C10 bevat de cellen van 
rij 5 tot rij 10 met de kolommen A, B en C. Gebruik een komma om individuele cellen 
aan te duiden (a25,c25,d25) 
 
Enkele voorbeelden:  
=sum(a1:a25,b1) Maakt de som van de eerste 25 rijen van kolom A en van 

de eerste rij van kolom B  
=average(a100:d100) Berekend de gemiddelde waarde van de eerste 4 

kolommen van rij 100 
=count(a1:m500) Telt de totale aantal cellen op van kolom A tot kolom M, 

vanaf rij  1 tot 100 
=(a6+d6)/e1 Maakt de som van de waardes in cellen A6 en D6, en 

deelt dit total door de waarde van cel E1 
 

Een formule moet altijd starten met het gelijk aan (=) symbool.  
Cellen van een andere tabel verwerken doet men best via de formule opbouw van de 
snelmenu, klik de gewenste cellen aan, en pas de formule verder aan vanuit de tekst 
editor. 
 
Een leuke extra, indien dadelijk Excel tabellen ingevoegd worden; kunnen een aantal 
formules uit Excel worden overgenomen. Typerende Excel formules zoals 
“concatenate” worden in deze AutoCAD versie nog niet ondersteund.  
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 BONUS TIP: Stel, men wenst een kolom met 
oplopende nummering. En in plaats van elke cel te 
gaan invullen: plaatst men het beginnummer in 
een eerste cel. Selecteer vervolgens de cel, en klik 

de “Auto Fill” aan (helderblauw blokje rechtonder) om 
deze onderaan een kolom te verplaatsen. De cellen 
worden hierdoor oplopend ingevuld. Om een interval 
tussen waardes te bekomen, typt men de twee eerste 
waardes (vb 100, 200,...) in een cel, selecteer deze dan 
allebei om auto fill de rest van de cellen in te vullen. 
Probeer automatisch uitvullen van een datum ook maar 
eens... 

4.2. FIELDS 
FIELD is op zich een 
zelfstandige functie die 
overal binnen AutoCAD, en 
dus ook aan een tabel kan 
verbonden worden.  
Het FIELD commando 
vertaalt een aantal 
objectdefinities en 
tekeningeigenschappen naar 
interaktieve tekst. 
Alle tekeningeigenschappen, 
zoals bestandsnaam, 
folderlokatie, auteur, 
plotschaal, maar ook de 
eigenschappen van gekozen 
objecten zoals lengte, layer 
of kleur, de naam of schaal 
van een blok – de 
mogelijkheden zijn enorm. 
De sterkte van een FIELD is 
dat de tekst die het weergeeft gekoppeld is aan een eigenschap. Wanneer deze 
“Properties” van tekening of objecten wijzigen, danook de tekstweergave van het 
field-commando. Zo kan men bijvoorbeeld waarde van de oppervlakte (Area) van 
een gesloten figuur met een field weergeven. Wijzigt de figuur, dan zal de 
tekstwaarde na “UPDATEFIELD” zich mee aanpassen. Ook bij het openen, opslaan, 
plotten of het regenereren van de tekening zullen de FIELD velden zich updaten. 
Een field kan men in een cel plaatsen, door in een geaktiveerde cel in tekstmodus te 
gaan en met RMK + Insert field vanuit de snelmenu de functie te lanceren. 
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4.3. INVOEGEN VAN BLOKKEN 
Wanneer men bijvoorbeeld een symbolenlegende op 
een tekening wenst te plaatsen, kan men hiervoor ook 
de tabelfunctie voor gebruiken. 
Tabellen laten toe om een blok in een cel op te nemen: 
klik op een cel + RMK Insert Block… en navigeer naar 
de gewenste blok. 
Verder kan men nog de uitlijning van de blok tov de cel 
meegeven, de rotatiehoek en de optie AutoFit die de 
grootte van de blok aan de cel zal aanpassen. 
In een tweede kolom kan men bijvoorbeeld met Field 
commando ook de bloknaam weergeven. 
 
Indien men een oplijsting wenst van alle blokken die in 
een tekening gebruikt werden, dan is dit proces te 
automatiseren via de “blokken en attribute extraction” (zie hoofstuk 0) 

5. INVOEGEN VAN EEN EXCEL TABEL 
Een vaak voorkomende handeling is een Excel tabel op een AutoCAD tekening 
plaatsen.  
En meestal gebeurd dit met het copy/paste handeling, waardoor de Excel tabel als 
een OLE object in de AutoCAD tekening gevoegd wordt. Op zich is dat OK, maar 
werken met OLE verbindingen kan verschillende ongewenste neveneffekten 
veroorzaken. 
 
Object Linking and Embedding ook bekend als OLE, is een techniek ontwikkeld 
door Microsoft. OLE zorgt voor communicatie tussen verschillende applicaties binnen 
Windows. Dit maakt het in de praktijk bijvoorbeeld mogelijk om in Word andere 
bestandstypen, zoals JPEG, in te voegen of als verwijzing op te nemen in het 
document.  
 
Een OLE object in een AutoCAD tekening vordert meer performantie, en benodigd 
voor correct gebruik de bronsoftware op de werkplek. Anders kan de AutoCAD 
tekening met OLE object wel geopend worden, maar kan het OLE object niet meer 
bewerken. Het is ook geweten dat bij het afdrukken van de tekening, er 
onregelmatigheden met de OLE op papier optreden. Daarom tracht ik persoonlijk 
zoveel mogelijk het gebruikt van OLE objecten binnen AutoCAD (maar ook Inventor) 
te beperken. 
 
Een betere manier om Excel gegevens op een AutoCAD tekening te plaatsen, is door 
deze in te voegen als een AutoCAD tabel. De Excel data wordt dan volledig 
geconverteerd naar AutoCAD objecten. Om dit zover te krijgen, zal men de Excel 
gegevens op een speciale manier moeten plakken in AutoCAD. En eigenlijk hebben 
we het daarmee al gezegd… 
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Navigeer vanuit AutoCAD naar het pulldownmenu Edit → Paste Special… en 
selecteer uit het lijstje “AutoCAD Entities” gevolgd door OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
De Excel gegevens worden vervolgens in AutoCAD gebracht als normale AutoCAD 
objecten, onder de vorm van een tabel, volgens de aktieve tabelstijl. 
 
 

 BONUS TIP: Omdat men in Excel een aantal uiteenlopende stijlinstellingen 
kan gebruiken, zoals het lettertype, kleuren, uitlijningen,…zal AutoCAD deze 
detecteren en ze ook opnemen in de AutoCAD tabel. De aktieve tabelstijl zal 
wel worden gebruikt, maar op verschillende objecten onderdrukt worden.  

De AutoCAD tabel heeft dan een ander uitzicht dan de tabelstijl toelaat. 
Om dit te verhinderen, moet men – alvorens de data naar AutoCAD over te brengen – 
de stijlaanpassingen in Excel verwijderen. Meest eenvoudig door de Excel data in een 
leeg blad te laten vallen met “Plakken Speciaal” vanuit het pulldown menu Bewerken, 
en voor de optie “Waarden” of “Formules” te kiezen. De oorspronkelijke 
stijlformatering wordt zodoende verwijderd.  
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5.1. DATA LINKS: AUTOCAD TABELLEN  EXCEL 
De AutoCAD tabellen 
bevatten intussen al heel 
wat functionaliteit, maar is 

nog steeds niet te vergelijken met 
het potentieel die Excell heeft. 
Wenst men de geavanceerde 
functies van Excel te behouden 
maar toch de tabel in AutoCAD 
gebruiken (maar niet als OLE 
object) - dan komt AutoCAD 2008 
met een data link op de proppen. 
Met deze nieuwe functie kan men 
een Excel rekenblad binden aan 
een AutoCAD document. De 
AutoCAD tabel functie (met tabelstijl 
naar keuze) wordt vervolgens 
gebruikt om de inhoud van de Excel 
tabel in te laden. 
 
Om dit te realiseren zal een fysieke 
link naar het Excel rekenblad 
moeten gelegd worden. Dit gaat als 
volgt: via pulldownmenu Tools → 
Data Links → Data Link Manager of 
met commandoingave  “datalink” - bekomt men het dialoogvenster van de Data Link 
Manager. Tik de “Create a new Excel Data Link” aan om aansluitend een logische 
naam voor de data link te vergeven (dit hoeft niet noodzakelijk de bestandsnaam van 
het xls bestand te zijn). In een volgend dialoogscherm zal men kunnen navigeren 
naar de Excel tabel zelf. Hierna bekomt men verdere opties zoals het bereik van de 
cellen en welk werkblad moet worden geselecteerd. Een preview geeft al een idee 
hoe de Excel tabel in AutoCAD zal worden weergegeven. 
Na het bepalen van de Data Link, zal men de tabel nog moeten invoegen volgens de 
eerder besproken methode van hoofdstuk 2: PLAATSEN VAN EEN TABEL. 
 
Wanneer de Tabel functie hierop 
gelanceerd wordt, plaatst men de 
keuze van de “Insert Options” op 
“From a data link” om zo de logische 
naam van eerder gemaakte datalink 
uit het keuzelijst op te halen. Maak 
keuze uit een beschikbare tabelsstijl 
en plaats de tabel. 
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Indien het xls bestand 
verder bewerkt wordt, 
zal in de AutoCAD 
Tray een melding 
verschijnen dat de 
data is gewijzigd. 
Bevestigd men in 
deze ballon om de 
AutoCAD tabellen met 
data link te updaten, dan zal de gewijzigde informatie van het Excel rekenblad 
opnieuw in de AutoCAD geladen worden. 
 
Het updaten van de Data link kan men ook benaderen via het pulldownmenu Tools 
→ Data Links → Update Data Links, via de commandoingave DATALINKUPDATE of 
zelfs via het icoontje in het dashbord. 
 
 
 
 

BONUS TIP: Andersom zou men ook de tabel vanuit AutoCAD kunnen 
editeren, en de wijzigingen vervolgens synchroniseren met het excel 
rekenblad. Een AutoCAD tabel met Data Link is initieel beveiligd en kan niet 
rechtstreeks bewerkt worden. Bij het editeren van een cel zal dit duidelijk 

gemaakt  worden met een hangslotje aan het dradenkruis. Dit kan men echter 
overstemmen door in de cel te klikken met RMK → Locking → Unlocked. De cel is 
hiermee vrijgemaakt voor bewerking. Na een inhoudsverandering van de autoCAD 
tabel moet men dus terug synchroniseren, weliswaar nu in de andere richting: 
schrijven naar het xls bestand. Via het pulldownmenu Tools → Data Links → Write 
Data Links brengt men dit tot stand. 
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BLOKKEN EN ATTRIBUTE EXTRACTION 
Goed om weten 
is ook de 

mogelijkheid om een 
oplijsting te maken van 
blokken en attributen in 
een tekening. Deze 
functie wordt de 
“Attribute extraction” 
genoemd en kan 
gestart worden vanuit 
pulldown menu Tools 
→ Attribute 
Extraction… of met de 
ingave EATTEXT op de 
commandoregel. 
Het opkomend 
dialoogvenster gidst u 
door een aantal stappen van de wizard, waarin u de tekening(en) of objecten moet 
aanduiden voor de data extractie, of de ingebedde blokken of X-refs moeten 
opgenomen worden, of enkel de blokken uit modelspace mogen gebruikt worden. Men 
kan ook nog de keuze maken uit alle gevonden data, welke objecten men wenst te 
gebruiken, en welke eigenschappen daarvan (figuur boven). 

 
Tenslotte kan men kiezen hoe deze 
resultaten moeten bewaard worden: 
als een AutoCAD tabel, of als een 
extern bestand waaronder het CSV, 
XLS, TXT en MDB tot de 
mogelijkheden behoren. 
Met AutoCAD 2007 is het wel 
mogelijk om de resultaten 

rechtstreeks met een AutoCAD tabel in te voegen. Waarbij de AutoCAD tabel 
bovendien ook nog interactief is, dwz zich mee zal aanpassen (afhankelijk van de 
geprojecteerde velden) aan de wijzigingen aan de blokken. 
Door de tabel te selecteren, vindt men onder de RMK snelmenu een optie “Update 
Table”.  
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